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RINGKASAN

Glanndy Parwati Putra, Jurusan Teknik Elektro, Fakultas Teknik Universitas Brawijaya,
Juli 2021, Pengendalian Kecepatan Motor Pompa Air 12V DC Menggunakan Kontroler PID
dengan Variasi Debit Air Pada Perkebunan Hidroponik, Dosen Pembimbing: Adharul
Muttagin dan Sapriesty Nainy Sari.

Pertambahan jumlah penduduk vyang tinggi di Indonesia mengakibatkan
berkurangnya jumlah lahan pertanian. Dampak dari kurangnya lahan pertanian di Indonesia
dapat menyebabkan sulitnya pencapaian peningkatan produksi pangan karena keterbatasan
lahan pertanian. Maka dari itu, sistem hidroponik digunakan sebagai solusi dari masalah
tersebut. Metode penanaman tanaman pada sistem hidroponik ini tidak menggunakan tanah,
melainkan menggunakan air sebagai media tanamnya. Hal itu membuat perawatan pada
sistem hidroponik cukup sulit, karena ada beberapa variabel yang harus dikontrol, yaitu pH
air, suhu, dan larutan nutrisi AB Mix. Maka dari itu, diperlukan sistem smart hydroponic
untuk memonitor dan mengontrol beberapa aspek tersebut. Dalam sistem tersebut,
digunakan aktuator berupa motor pompa air 12V DC untuk mengubah nilai dari variabel pH
air maupun larutan nutrisi AB Mix apabila sensor membaca nilai tidak sesuai yang
diinginkan.

Namun, setelah proses penyemprotan larutan terdapat jeda pembacaan sensor selama
10 menit. Hal ini menyebabkan petani tidak dapat melihat nilai variabel yang ada di tandon
secara langsung. Maka dari itu, penelitian ini bertujuan untuk mengendalikan kecepatan
motor pompa air 12V DC agar mempercepat penyemprotan larutan dengan cara
mempercepat respon peralihannya sehingga jeda pembacaan sensor bisa kurang dari 10
menit. Kontroler yang digunakan adalah kontroler PID sebagai pengendali kecepatan dari
motor pompa air 12V DC. Dengan mengubah nilai dari debit air motor pompa air 12V DC
diharapkan dapat mempertahankan kecepatannya sehingga waktu untuk mencapai setpoint
dapat dipercepat.

Pada penelitian ini nilai setpoint yang digunakan adalah 500 mL/min, 1000 mL/min,
1500 mL/min, dan 2000 mL/min. Ada beberapa nilai yang diamati pada saat pengujian, yaitu
overshoot, error steady state, rise time, dan settling time. Hasil yang diperoleh dari penelitian
ini adalah bahwa perubahan nilai setpoint tidak mempengaruhi dari nilai performansi sistem,
pada sistem open-loop memiliki overshoot sebesar 1.96%, error steady state sebesar 0%,
mempunyai nilai rise time sebesar 0.0946 detik, dan nilai settling time sebesar 0,146 detik.
Sehingga performansi sistem sudah sesuai dengan karakteristik yang diinginkan.

Kata kunci: Hidroponik, Motor Pompa Air DC, Kontroler PID



19e°qn°A101150d2. | d (@
praeqnAioyisod VAVIIMVYS (@

k- I N



L]
oI

b.ac

.

repository.u

IVERSITA

UN

<
<
s
:

SUMMARY

Glanndy Parwati Putra, Department of Electrical Engineering, Faculty of Engineering,
Universitas Brawijaya, July 2021, Speed Control of DC Motor Water Pump 12V Using PID
Controller With Water Flow Variations in Hydroponic Plantation , Dosen Pembimbing:
Adharul Muttagin dan Sapriesty Nainy Sari.

The high population growth in Indonesia has resulted in a reduction of the amount
of agricultural land. It is difficult to achieve increased food production due to limited
agricultural land. Therefore, a hydroponic system can be used as a solution to this problem.
The method of planting plants in this hydroponic system does not use soil, but uses water as
the planting medium. This makes maintenance on a hydroponic system quite difficult,
because there are several variables that must be controlled, including pH, temperature, and
AB Mix nutrient solution. Therefore, a smart hydroponic system is needed to monitor and
control some of these aspects. In the smart hydroponic system, an actuator in the form of a
12V DC water pump motor is used to change the value of the water pH variable and the AB
Mix nutrient solution if the sensor reads the value not as desired..

However, after the process of spraying the solution there is a pause in sensor
readings for 10 minutes. This causes farmers to not be able to see the value of the variables
in the reservoir directly. Therefore, this study aims to control the speed of the 12V DC water
pump motor in order to accelerate the spraying of the solution by accelerating the transition
response so that the sensor reading delay can be less than 10 minutes. The controller used
is the PID controller as the speed controller of the 12V DC water pump motor. By changing
the value of the water discharge of the 12V DC water pump motor, it is expected to be able
to maintain its speed so that the time to reach the setpoint can be accelerated.

In this study, the setpoint values used were 500 mL/min, 1000 mL/min, 1500 mL/min,
and 2000 mL/min. There are several values observed during the test, namely overshoot,
steady state error, rise time, and settling time. The results obtained from this study are that
the change in the setpoint value does not affect the system performance value, the open-loop
system has an overshoot of 1.96%, a steady state error of 0%, a rise time value of 0.0946
seconds, and a settling time value of 0.146. seconds. So that the system performance is in
accordance with the desired characteristics.

Keywords: Hydroponics, DC Water Pump Motor, PID Controller
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BAB |
PENDAHULUAN

1.1  Latar Belakang

Badan Pusat Statistik (2020) mengungkapkan bahwa lahan pertanian di Indonesia
pada tahun 2019 berkurang sebesar 6,15% dibanding tahun 2018. Meningkatnya jumlah
penduduk menyebabkan ketersediaan lahan pertanian semakin sempit karena digunakan
untuk perumahan dan perluasan perkotaan. Hal ini mempersulit pencapaian peningkatan
produksi pangan karena keterbatasan lahan pertanian (Rosliani dan Sumarni, 2005).

Seiring dari permasalahan tersebut, banyak penelitian yang dikembangkan untuk
mencari solusi tepat dari permasalahan tersebut. Metode penanaman tanaman terus
dikembangkan, guna mencapai peningkatan produksi pangan. Salah satu inovasi untuk
mengatasi kurangnya lahan pertanian di perkotaan adalah dengan metode penanaman
tanaman tanpa menggunakan media tumbuh dari tanah melainkan menggunakan air sebagai
media tumbuh yang disebut sistem hidroponik. Sistem hidroponik dikenalkan dan
dikembangkan secara komersial pada awal tahun 1900-an di Amerika Serikat. Di Indonesia,
sistem hidroponik telah mulai mendapat perhatian masyarakat dan berkembang sejak tahun
delapan puluhan, yang dimulai oleh beberapa pengusaha di daerah perkotaan (Rosliani dan
Sumarni, 2005).

Pada perawatannya, tanaman yang menggunakan sistem hidroponik perlu
memperhatikan beberapa aspek, diantaranya pengendalian pH, nutrisi tanaman, dan suhu
agar menghasilkan kualitas tanaman yang baik (Gent, 2016). Kenaikan pH akan
menyebabkan timbulnya bintil akar dan proses penyerapan nutrisi nitrogen dan fosfor
terhambat. Sedangkan apabila tanaman kekurangan nutrisi, maka akan menyebabkan
tanaman layu (Lubis et al, 2015). Maka dari itu, perlu dirancang suatu sistem smart
hydroponic untuk memonitor dan mengendalikan beberapa aspek tersebut. Salah satu
aktuator dalam sistem ini adalah motor pompa air DC untuk mengendalikan pH maupun
nutrisi tanaman dengan cara menyemprotkan larutan asam fosfat maupun larutan nutrisi AB
Mix pada tandon. Namun, setelah proses penyemprotan larutan terdapat jeda pembacaan
sensor selama 10 menit untuk proses pencampuran pada tandon karena sirkulasi air tandon
yang cukup jauh. Hal ini menyebabkan petani tidak dapat memonitor nilai variabel secara

langsung karena harus menunggu jeda tersebut.



-
o
<

e
s |
—
jE—
o

—
L= ]
o
e
(=5 ]
j=—

Pada penelitian ini akan dilakukan pengendalian kecepatan motor pompa air DC
menggunakan kontroler PID yang bertujuan untuk mempercepat penambahan larutan pada
tandon air dengan cara mempercepat respon peralihannya sehingga jeda pembacaan sensor
dapat dipercepat dan petani tidak perlu menunggu jeda selama 10 menit. Harapannya
penelitian ini dapat meningkatkan kemampuan kerja motor pompa air DC.

1.2 Rumusan Masalah
Sesuai dengan latar belakang yang telah diuraikan di atas maka rumusan masalah

untuk penelitian ini adalah:

1. Bagaimana mengatur kecepatan motor pompa air DC menggunakan kontroler PID?

2. Bagaimana respon peralihan motor pompa air DC setelah menggunakan kontroler
PID dengan variasi debit air yang diberikan?

3. Bagaimana pengaruh nilai setpoint pada sistem setelah diberikan kontroler PID?

.3 Batasan Masalah
Pada penelitian ini tegangan masukan (Vqc) ditentukan sebesar 12V DC.

1

1

2. Daya motor pompa air DC pada penelitian ini adalah 6W.

3 Arus nominal motor pompa air DC pada penelitian ini adalah 0,5A.

4 Parameter tegangan dan arus didapatkan dari motor pompa air DC pada perkebunan
Ifresh Hydrofarm

5. Menggunakan aplikasi MATLAB untuk pemodelan keseluruhan sistem.

1.4 Tujuan Penelitian
Membandingkan respon peralihan kecepatan motor pompa air DC tanpa

menggunakan PID Controller dan menggunakan PID Controller yang dilakukan di dalam
software MATLAB.

1.5 Manfaat Penelitian
Adapun manfaat dari penelitian ini adalah sebagai berikut:
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£t Bagi penulis, mampu memberikan pembelajaran dalam mengatur kecepatan motor
pompa air DC.
2. Bagi pembaca, mampu memberikan wawasan mengenai cara kerja motor pompa air

DC dan sistem pengendalinya.
3. Bagi akademisi, diharapkan mampu digunakan sebagai rujukan penelitian

selanjutnya mengenai pemodelan sistem pengendali pada motor pompa air DC.

1.6 Sistematika Penulisan
Sistematika pembahasan yang akan digunakan pada penelitian ini adalah:

BAB | : PENDAHULUAN

Bab ini memuat tentang latar belakang, rumusan masalah, batasan masalah, tujuan,
manfaat, dan sistematika penulisan.
BAB 11 : TINJAUAN PUSTAKA

Bab ini menguraikan tentang dasar teori yang mendukung terhadap penelitian yang
akan dilakukan dan untuk mendukung permasalahan yang akan dibahas pada penelitian ini.
BAB 11l : METODE PENELITIAN

Bab ini menguraikan tentang metode dan langkah kerja yang terdiri dari studi
literatur, pengambilan data, perhitungan dan analisis, serta pengambilan kesimpulan dan
saran.
BAB IV : PEMBAHASAN

Bab ini menguraikan tentang data-data yang diperlukan, dengan analisis terhadap
masalah yang akan diajukan sehingga diperoleh hasil dalam penelitian ini.
BAB V : KESIMPULAN DAN SARAN

Bab ini memuat kesimpulan dan saran.
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BAB Il
TINJAUAN PUSTAKA

2.1 Motor DC
Mesin listrik merupakan bagian terbesar dalam kehidupan manusia di era modern ini.

Pemakaian mesin listrik telah meliputi segala bidang mulai dari peralatan rumah tangga,
peralatan industri, robot, pesawat ruang angkasa, komputer, sarana transportasi, bahkan
peralatan audio video pun menggunakan mesin listrik. Terdapat dua jenis mesin listrik yang
ada di kehidupan sehari-hari, yaitu mesin AC dan mesin DC. Mesin listrik yang paling sering
digunakan dalam kehidupan sehari-hari adalah mesin DC. Mesin DC terdapat dua jenis
yaitu, dapat berupa generator DC maupun motor DC. Pada saat digunakan sebagai generator
DC, masukan dari generator DC berupa energi mekanik yang diubah menjadi energi listrik.
Lalu, penggerak utama akan memutar jangkar mesin DC, dan menghasilkan daya. Pada saat
digunakan sebagai motor DC, masukan dari generator DC berupa energi listrik yang diubah
menjadi energi mekanik (Sen, 1996).

Electrical Mechanical
system Electric system
e i machine T n

——— > Motor
Energy flow
Generator <=———

Gambar 2.1 Konversi Energi Elektromekanik
Sumber: (Sen, 1996)

Motor DC adalah jenis motor listrik yang paling sering digunakan sebagai aktuator
dalam sistem kontrol. Kumparan medan pada motor DC disebut stator (bagian yang tidak
berputar) dan kumparan jangkar yang disebut rotor (bagian yang berputar). Motor DC
membutuhkan suplai tegangan searah pada kumparan medan untuk diubah menjadi energi
mekanik. Untuk memberikan tegangan pada kumparan medan membutuhkan sikat yang
menyentuh komutator, dua bagian seperti cincin terputus yang terhubung pada ujung lilitan.
Kumparan dalam satu lilitan disebut armature (jangkar). Armature adalah sebutan untuk
komponen yang berputar di antara medan magnet. Rangkaian ekivalen motor DC magnet

permanen dapat dilihat dalam Gambar 2.2.
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Gambar 2.2 Rangkaian ekivalen motor DC magnet permanen
Sumber: (Dorf, R. C & Bishop, R. H., 2011)
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Pada motor DC magnet permanen, arus kumparan medan Irdibuat konstan. Diagram

blok pengontrolan kecepatan motor DC magnet permanen dapat dilihat dalam Gambar 2.3.

Disturbance
T(5)

Armature Speed
+ K Tuls) _% Ti(s) 1 w(s) Position
Vs — > ’ ,
u(s) —*(_ — R +L.5 i Js+ b 5 i)

L

Back electromotive force

Gambar 2.3 Diagram blok pengontrolan motor DC magnet permanen
Sumber: (Dorf, R. C & Bishop, R. H., 2011)

Apabila disturbance (gangguan) Tq (S) = 0, maka fungsi alih motor DC adalah
(Dl L e e @@ B rawijaya  Univers (2-1)

Va(s)  (R+LyS)(Js+b)+(KeKy,)

Dengan:
Kt = Konstanta motor
<C Kw = Konstantan back electromotive force
2 R = Resistansi armature
“E Lm = Induktansi armature
Eé J = Inersia
:;:CJ b = Gesekan
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Prinsip Kerja Motor DC

Pada dasarnya prinsip kerja dari motor DC adalah jika sebuah
konduktor dialiri arus listrik dan diletakan pada medan magnet, maka akan
terjadi gaya pada konduktor tersebut yang akan membuat konduktor berotasi.

Gaya medan magnet pada konduktor yang dialiri arus listrik dapat dilihat

®
\Q LA B
— - — —— ;

pada Gambar 2.4.

' l
Lo
Gambar 2.4 Gaya Medan Magnet pada Konduktor yang Dialiri Arus Listrik
Sumber: (Dhogal, 1985)

Dalam Gambar 2.4 terlihat sebuah konduktor dialiri arus listrik dan
diletakan pada medan magnet tetap. Karena itu, akan terjadi gaya pada
kumparan sisi A dan pada kumparan sisi B. Menggunakan aturan tangan kiri
Fleming dapat ditentukan arah putaran berlawanan arah jarum jam. Gaya
akan terus ada sampai konduktor meninggalkan medan magnet. Untuk
membuat putaran yang terus menerus dibutuhkan konduktor yang banyak,
sehingga jika sebuah konduktor meninggalkan medan magnet saat itu juga
akan ada konduktor yang masuk ke medan magnet. Ketika kumparan berputar
180 derajat, maka arus listrik pada sisi A dan B akan berubah arah. Maka dari
itu, komutator berfungsi untuk membalik arah arus dalam kumparan (Dhogal,
1985).

Konstruksi Motor DC
Motor DC adalah perangkat konversi energi elektromekanis yang

memiliki kutub menonjol yang dieksitasi oleh satu atau lebih belitan medan.
Belitan jangkar motor DC terdapat pada rotor, dengan arus yang dihantarkan
melalui sikat arang yang bersentuhan dengan segmen komutator. Tampilan
dari konstruksi motor DC ditunjukan pada Gambar 2.5 dan skematik dari

motor DC dua kutub ditunjukan pada gambar 2.6
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2.1.3

Gambar 2.5 Konstruksi Motor DC
Sumber: (EI-Hawary, 2002)

Armature coil

Carbon brush

Rotation

Copper commutator
segmenis

Gambar 2.6 Skematik motor DC dua kutub
Sumber: (EI-Hawary, 2002)

Pada kecepatan konstan, tegangan induksi muncul pada kumparan
jangkar. Tegangan terinduksi adalah tegangan bolak-balik dan harus
disearahkan untuk menghasilkan tegangan DC. Penyearahan secara
tradisional dilakukan dengan menggunakan komutator, yaitu silinder yang
dipasang pada rotor dan dibentukdari segmen tembaga. Lalu, segmen
komutator akan bersentuhan dengan sikat arang. Pada Gambar 2.6 terlihat
bahwa komutator menghubungkan sisi kKumparan yang berada di bawah kutub
selatan ke sikat positif dan dibawah kutub utara ke sikat negatif yang
dilakukan secara terus menerus. Komutator pada dasarnya adalah penyearah
mekanis gelombang penuh. Medan magnet yang muncul karena tegangan DC
di belitan medan bersifat statis. Arus jangkar menciptakan distribusi fluks
magnet yang sumbunya tegak lurus terhadap fluks medan. Interaksi keduanya
akan menciptakan torsi di motor DC (El-Hawary, 2002).

Motor Pompa Air DC Tipe 365B7



e Prinsip kerja motor pompa air beroperasi dengan membuat perbedaan
A di sisi bagian tekanan dan di sisi bagian hisap yang dapat dilihat pada Gambar
'g 2.7. Pompa air memiliki dua kegunaan, diantaranya:
o s Memindahkan cairan dari satu tempat ke tempat lainnya
o
E 2. Mensirkulasikan cairan pada suatu sistem
o
=
a2
-

Sisi hisap <— — Sisi tekanan

ﬁ},

Gambar 2.7 Motor Pompa Air DC Tipe 365B7
Spesifikasi motor pompa air DC Tipe 365B7 menggunakan tegangan
DC sebesar 12V dan arus yang mengalir sebesar 0,5- 0,7A seperti yang
ditunjukan pada Tabel 2.1.
Tabel 2.1 Spesifikasi Motor Pompa Air DC Tipe 365B7

Tegangan 12V DC

Arus kerja 0,5-0,7A

Arus tanpa beban 0,18A

Debit 2L/min

Dimensi 90 x 40 x 35 mm

2.2 Kontroler Proporsional Integral Derivative (PID)

Kontroler adalah komponen yang berfungsi untuk mengurangi kesalahan pada
sistem. Tipe kontroler yang paling populer adalah kontroler PID. Kegunaan kontroler PID
terletak pada penerapan di sebagian besar sistem kontrol. Khususnya, ketika model
matematis plant tidak diketahui dan metode desain analisis tidak dapat digunakan, kontroler
PID terbukti berguna untuk masalah tersebut (Ogata, 2010).

Beberapa terminologi dasar untuk-mempermudah memahami PID Controller
(Rokhmah, 2018):

a. Error: Selisih antara nilai setpoint dan output dari suatu sistem.

b. Proportional (P): Proporsional berbanding lurus dengan kesalahan saat ini, pengendali
proporsional juga bertindak sebagai penguat yang mampu mengubah output dari sistem
secara proporsional tanpa memberikan efek dinamik pada kinerja pengendali tersebut.

c. Integral (1): Integral bergantung pada kesalahan kumulatif yang dibuat selama jangka
waktu (t), pengendali integral merupakan pengendali yang berfungsi untuk memperbaiki
respon tunak/steady state dari sistem sehingga pengendali ini mampu memperkecil error

sistem.

&
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d. Derivative (D): lIstilah turunan tergantung laju perubahan kesalahan. Pengendali ini
merupakan suatu pengendali yang berfungsi untuk memperbaiki respon transien dari
sistem.

e. Constant (faktor): Setiap istilah P, I, D dimasukkan dalam kode dengan mengalikannya
terhadap konstanta masing-masing.

e P-faktor (Kp): Nilai konstan yang digunakan untuk menambah atau mengurangi dampak
proporsional.

e D-faktor (Kgq): Nilai konstan yang digunakan untuk menambah atau mengurangi
dampak dari derivatif.

e [-faktor (Ki): Nilai konstan yang digunakan untuk menambah atau mengurangi dampak

dari integral.

Kontroler PID merupakan kombinasi dari tiga pengendali, yaitu pengendali
Proporsional disingkat P, pengendali Integral disingkat | dan pengendali Diferensial
disingkat D. Ketiga jenis pengendali ini memberikan respon yang berbeda-beda pada proses
orde satu, proses orde dua, proses orde banyak. Ketiga jenis pengendali ini masing-masing
mempunyai kelebihan dan kekurangan (Yudaningtyas, 2017). Diagram balok dari kontroler
PID ditunjukan pada Gambar 2.8.

v e L+ Kd.s M(s)
Gambar 2.8 Diagram blok kontroler PID
Sumber: (Yudaningtyas, 2017)
Adapun fungsi alihnya adalah sebagai berikut:
M(s) K; A
E(s)_KP+s+Kd'S .................................................................................................... (2
2)

Kp sebagai penguatan proporsional dan K disebut konstanta integral, dan Ky yang
ketiganya dapat ditentukan. Tuning PID dapat dilakukan secara manual dengan cara
menambahkan gain pada K,, Ki, dan Kq (Dorf, R. C & Bishop, R. H., 2011). Efek dari
menambahkan gain pada parameter PID dapat dilihat pada Tabel 2.2.
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Tabel 2.2 Efek menambah gain pada parameter PID
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Parameter Rise Time Overshoot | Settling Time Error
Kp Berkurang Bertambah | Sedikit berubah | Berkurang
Ki Berkurang Bertambah | Bertambah Dihilangkan
Kd Sedikit berubah Berkurang | Berkurang Tidak berpengaruh

2.3 Arduino Uno
Arduino Uno adalah arduino board yang menggunakan mikrokontroler ATmega328.

Arduino Uno memiliki 14 pin digital (6 pin dapat digunakan sebagai output PWM), 6 input
analog, sebuah 16 MHz osilator kristal, sebuah koneksi USB, sebuah konektor sumber
tegangan, sebuah header ICSP, dan sebuah tombol 26 reset. Arduino Uno memuat segala hal
yang dibutuhkan untuk mendukung sebuah  mikrokontroler. Hanya dengan
menghubungkannya ke sebuah komputer melalui USB atau memberikan tegangan DC dari
baterai atau adaptor AC ke DC sudah dapat membuatnya bekerja. Arduino Uno
menggunakan ATmegal6U2 yang diprogram sebagai USB-to-serial converter untuk
komunikasi serial ke komputer melalui port USB. Tampak atas dari arduino uno dapat dilihat
pada Gambar 2.9.

2.4 Driver Motor BTS7960

Gambar 2.10 Driver Motor H-Bridge BTS7960

Pada driver motor DC ini dapat mengalirkan arus hingga 43A dan memiliki fungsi
PWM. Tegangan sumber DC yang dapat diberikan diantara 5.5V-27V DC, sedangkan
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tegangan input level diantara 3.3V-5V DC, driver motor ini menggunakan rangkaian full H-
bridge dengan IC BTS7960 dengan perlindungan saat terjadi panas dan arus berlebih. Driver
motor H-Bridge BTS7960 dapat dilihat pada Gambar 2.10 dan spesifikasi dari driver motor
BTS7960 dapat dilihat pada Tabel 2.3

Tabel 2.3 Spesifikasi Motor Driver BTS7960

Input Voltage 6V — 27V
Model IBT-2
Maximum Current 43A

Input Level 3,3V -5V
Control Mode PWM or Level
Duty Cycle 0—100%

2.5  Pulse Width Modulation (PWM)
PWM adalah sebuah Teknik modulasi dengan mengubah lebar pulsa dengan nilai

frekuensi dan amplitudo yang tetap. PWM ini digunakan untuk menghasilkan sinyal analog
dari sebuah perangkat digital seperti mikrokontroler. PWM ini memiliki beberapa jenis
teknik dalam pemodulasiannya, seperti Digital PWM, Programmed PWM, Sinusoidal PWM
(SPWM), dan juga Space Vector Pulse Width Modulation (SVPWM).

Lebar pulsa dalam PWM dapat diatur menggunakan Duty Cycle. Duty Cycle
merupakan persentase periode antara sinyal High dengan sinyal Low, dan persentase duty
cycle akan berbanding lurus dengan tegangan rata-rata yang dihasilkan (Budijanto, 2018).
Penjelasan mengenai PWM dapat dilihat pada Gambar 2.11.

Aprpdiudc

Gambar 2.11 Sinyal PWM
Sumber: (Budijanto, 2018)

Pada Gambar 2.11, ton merupakan waktu saat tegangan berlogika 1 atau berada pada
posisi High dan tor adalah waktu saat tegangan berlogika 0 atau berada pada posisi Low.

Nilai Duty Cycle dapat didefinisikan dengan persamaan:
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2.6 Sensor Water Flow
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Gambar 2.12 Sensor Water Flow

Sensor Water Flow seperti pada Gambar 2.12 adalah sensor yang mendeteksi aliran
air pada saat melewati sensor tersebut. . Sensor ini terdiri dari body katup plastik, rotor air,
dan sensor hall-effect. Ketika air mengalir melewati rotor, rotor akan berputar. Kecepatan
putaran ini akan tergantung dengan kecepatan atau besarnya aliran air yang melewati sensor
tersebut. Sensor ini tidak akan menghasilkan tegangan apabila sensor belum dialiri air atau
belum bekerja dan baru akan menghasilkan tegangan ketika sensor telah dialiri air. Sensor
hall-effect yang terdapat dalam sensor water flow tersebut akan mengeluarkan output pulsa
sesuai dengan besarnya aliran air. Spesifikasi dari sensor water flow dapat dilihat pada Tabel
2.4.

Tabel 2.4 Spesifikasi Sensor Water Flow

Tegangan 5—24V DC
Arus maksimum 15 mA

Berat 43¢

Operasi kelembaban 35-90% RH
Operasi tekanan air < 1,75 Mpa
Rentang debit 1 —30L/min
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BAB 1
METODE PENELITIAN
Metode penelitian pada dasarnya merupakan cara ilmiah untuk mendapatkan
informasi dengan tujuan tertentu. Pada bab ini bertujuan untuk merancang suatu sistem
pengendalian kecepatan motor pompa air menggunakan kontroler PID yang bertujuan untuk
mendapatkan performansi sistem yang diharapkan. Penyelesaian rumusan masalah dalam
penelitian ini ada beberapa tahapan, yaitu studi literatur, perancangan blok diagram sistem,
karakterisasi setiap subsistem, penentuan fungsi alih motor DC, penentuan parameter
kontroler PID, pengujian sistem, pengambilan kesimpulan. Adapun diagram alir metodologi

tersebut ditunjukan pada Gambar 3.1.

Studi literatur

!

Perancangan Blok Diagram
Sistem

!

Karakterisasi Setiap
Subsistem

!

Penentuan Fungsi Alih
Motor DC

!

Penentuan Parameter
Kontroler PID

!

Penguijian Sistem

!

Pengambilan Kesimpulan

Selesai

.

Gambar 3.1 Diagram Alir Metode Penelitian
Sumber: (Penulis, 2021)

3.1  Studi Literatur
Studi literatur pada penelitian ini dilakukan untuk mendapatkan informasi dan

pemahaman tentang konsep dan teori yang digunakan sebagai acuan dalam penyelesaian

penelitian ini. Studi literatur pada penelitian ini meliputi teori-teori mengenai motor DC,

15
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kontroler PID, serta metode tuning PID. Penulis menggunakan acuan buku, jurnal, skripsi,
dan internet untuk tahap ini.
3.2  Blok Diagram Sistem

Blok diagram sistem kontrol motor pompa air DC ini menjelaskan ketika sistem
diberi setpoint tertentu menggunakan arduino, maka setpoint tersebut dikirimkan ke motor
DC melalui driver motor agar menggerakkan pompa untuk mengalirkan air. Setelah itu,
output akan dibaca dengan sensor water flow untuk melihat error yang terjadi. Apabila
terjadi error, kontroler PI1D akan menghilangkannya agar keluaran dari sistem sesuai dengan

setpoint yang dapat dilihat seperti pada Gambar 3.2.

Set Point
(mL/min)

Qutput
debit
Driver Motor » Motor DC

PID Pompa Air

Y

Y

Sensor Water |
Flow

Gambar 3.2 Blok Diagram Sistem
Sumber: (Penulis, 2021)

3.3 Karakterisasi Motor DC

Pada bagian ini diuraikan tentang bagaimana memperoleh karakteristik perubahan
tegangan input motor DC terhadap perubahan debit keluaran motor pompaair DC. Tegangan
masukan diubah menggunakan metode Pulse Width Modulation (PWM) dengan jangka nilai
dari 0-255 pada program arduino. Peralatan yang digunakan pada penelitian untuk menentukan
karakterisasi motor DC antara lain:
Motor DC 365b-7
Power Supply 12V
Mikrokontroler Arduino Uno
Driver motor BTS7960
Sensor Water Flow
Laptop
Software Arduino IDE

NTo garhs weN e

Adapun prosedur percobaan untuk menentukan karakterisasi motor DC antara lain:
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.'Ef g Pin VCC, R_EN, dan L_EN pada driver motor dihubungkan pada pin VIN pada

"c'é. mikrokontroler Arduino UNO. Lalu, pin GND pada driver motor dihubungkan pada
‘g pin GND pada mikrokontroler Arduino UNO.

f" 2. Pin M+ dan M- pada driver motor dihubungkan dengan motor DC 365b-7 dan pin
§ B+ dan B- pada driver motor dihubungkan dengan power supply 12V DC.

g 3. Nilai PWM diubah sesuai dengan Tabel 3.1 pada software Arduino IDE.

— 4. Debit keluaran diukur selama satu menit menggunakan sensor water flow

5. Hasil pengujian motor pompa air DC dicatat dalam tabel 4.1 pada bab Hasil dan
Pembahasan

Tabel 3.1 Data Pengujian Motor Pompa Air dengan PWM

Duty Cycle (%) PWM
0 0
5 13
10 25
15 38
20 51
25 64
30 77
35 90
40 102
45 115
50 127
55 140
60 153
65 166
70 178
75 191
80 204
85 217
90 229
95 242
100 255

3.4 Penentuan Fungsi Alih Motor DC
Pada penelitian ini, motor pompa air DC belum diketahui fungsi alihnya. Parameter

kontroler PID ditentukan setelah fungsi alih dari motor pompa air DC didapatkan, dengan
demikian perlu dicari terlebih dahulu fungsi alih motor DC. Fungsi alih didapatkan dari
dengan pemodelan menggunakan System Identification Toolbox pada MATLAB. Langkah-
langkah yang dilakukan untuk menentukan fungsi alih motor DC sebagai berikut:

1. Mencari keluaran motor DC dari masukan berupa PWM yang diatur seperti Tabel 3.1.
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2. Setelah didapatkan data masukan dan keluaran, selanjutnya data di-import ke

o
—
=. 4 Time Plot: ul-=yi _ D |
- File Options Style Channel Experiment Help
(=1
—
]
L= Input and output signals
2000 T T T T : I | I I
a 8
= 1000 | _-----/.M“"m“ _
B |
-
0 — 1 | 1 I | | I I
300 T T T T : | | I I
: ,—l_'_ '_1—'__
b ’_|—’ : |
0 ,_‘_'_ ) | i . | | I I
0 1 2 3 4 5 6 . ’ g J
Time

Gambar 3.3 Masukan dan Keluaran Motor Pompa Air DC

3. Data Keluaran dari motor yang didapatkan dari masukan berupa PWM. Kemudian di-

import pada block System Identification Toolbox seperti dalam Gambar 3.4

4 System Identification - Untitled - O X
File Options Window Help
Import data ~ Import models ~
‘ Operations ‘
[
< Preprocess v T
mydata i 11
= mydata
Working Data
Estimate — v
Data Views Model Views
To To
0 Workspace || LTI Viewer [IModel output [[] Transient resp [] Nonlinear ARX
[ Data spectra _ [IModel resids [ Frequency resp Hamm-Wiener
[ Frequency function [[N [ Zeros and poles
Trash mydala [ Moise spectrum
Validation Dala

Gambar 3.4 System Identification Toolbox
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4. Setelah melakukan estimasi model berdasarkan data yang didapatkan, didapatkan fungsi

alih motor pompa air DC dengan best fits sebesar 95,54% seperti Gambar 3.5

4. Model Output: y1 - O X

File Options Style Channel Experiment Help

Measured and simulated model output

2000
Best Fits

tf1: 95.54

1500

1000 1

500 r

Gambar 3.5 Hasil Estimasi Model

Fungsi alih dari hasil estimasi motor DC berdasarkan input dan output dapat dilihat
dalam Gambar 3.6. Pada Gambar 3.6 diperoleh fungsi alih motor DC adalah:

6(s) _ 9,224 -
S T srioee - IR B T (3-1)

4. Data/model Info: tf1 - O x
Model name: 1
Color: [0,0.5,0]
From input "ul" to output "yl": ~
9.224

s"2 + 0.6216 s + 1.086
Nams: tfl
Continuous-time identified transfer function. v
< >

Diary and Notes

% Import mydata

% Transfer function estimation
Options = tfestOptions;
Options.Display = 'on';
Options.WeightingFilter = [];

Show in LTI Viewer

Present Export Close Help

Gambar 3.6 Model Fungsi Alih Motor DC

Selanjutnya fungsi alih tersebut diberi masukan berupa unit step untuk melihat

respon keluaran dari fungsi alih yang ditunjukan pada Gambar 3.7.
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4 System Identification: LTI Viewer - m} x
File Edit Window Help
D& %S E
Step Response
From: u1 To: y1
12 — T T
N
10 : \\
[T SRR P L e rrE—
8 \\\ /
® _
°
=
3 6
5
<
4t
2t
0 / L L L L L L L L
0 2 4 6 8 10 12 14 16 18
Time (seconds)
Linear System Analyzer

Gambar 3.7 Step Response dari Fungsi Alih
3.5 Penentuan Parameter Kontroler PID dengan PID Tuner pada MATLAB
Pada penelitian ini untuk menentukan parameter dari kontroler PID akan menggunakan
toolbox pada MATLAB yaitu PID Tuner. Langkah-langkah untuk mendapatkan parameter
Kp, Ki, Kd dengan PID Tuner adalah sebagai berikut:
1. Mendapatkan fungsi alih dari motor pompa air DC dengan menggunakan toolbox yang
ada pada MATLAB.
2. Fungsi alih di-import pada toolbox PID Tuner.
3. Setelah itu respon dari motor pompa air akan muncul. Pada penelitian ini respon sistem

ditunjukan pada Gambar 3.8.

4 System Identification: LTI Viewer - O X

File Edit Window Help

D& %S |E
Step Response
- From: u1 To: y1
] .
/i System: it System: tf1
10l { ooy i IO: utto y1
Peak amplitude: 11.7 Settiing time (seconds): 10.8
L. .. Overshool (%): 37.4 === mmimimimimi— s
[ T Attime (seconds): 3.11 il ==
L < ~ i
k3 i [i system: tf1 i
2 4! [louioy }
g— || Rise time (seconds): 1.27 ;
< . i
| I 1
4 i i
i i
AR i
I I I 1
2rif i 1
[ ! 1
I I I !
0 /] i i i
0 2 4 6 8 10 12 14 16 18

Time (seconds)

Linear System Analyzer

Gambar 3.8 Respon Sistem
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Pada Gambar 3.8 dapat dilihat sistem memiliki rise time sebesar 1,27 detik, settling
time sebesar 10,8 detik dan terdapat overshoot sebesar 37,4%. Sedangkan untuk performansi
sistem yang diinginkan adalah sebagai berikut:

1. Sistem memiliki nilai rise time kurang dari 1 detik
2. Settling time pada sistem kurang dari 5 detik
3. Overshoot tidak lebih dari 20%

4. Langkah selanjutnya adalah mengatur nilai response time dan transient behavior yang

diinginkan dengan menggunakan tuning tools seperti pada Gambar 3.9. Maka, didapat

parameter seperti yang ditunjukan pada Tabel 3.2.

I T T : 9_4
Slower Response Time (seconds) Faster
I L Ll T i T 1
Aggressive Transient Behavior Robust
TUNING TOOLS

Gambar 3.9 Tuning Tools

Tabel 3.2 Parameter Kontroler

Parameter Nilai
Kp 3,156
Ki 1,0796
Kd 2,3066

Setelah dilakukan tuning menggunakan PID Tuner, kemudian dilakukan pengujian
terhadap sistem yang diberi kontroler PID dengan cara memberi masukan unit step pada

sistem open-loop.

3.6 Perangkat Keras

Komponen perangkat keras yang digunakan terdiri dari power supply 220V AC to
12V DC, motor pompa air tipe 365B7 12V DC, arduino UNO, sensor water flow, driver
motor H-Bridge BTS7960, dan kabel penghubung. Wiring diagram pada perangkat keras
sistem dapat dilihat pada Gambar 3.10.

-

Gambar 3.10 Perangkat Keras Sistem
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BAB IV
HASIL DAN PEMBAHASAN

Pengujian sistem dilakukan untuk mengetahui sistem yang dirancang sesuai dengan
yang ditentukan dan mengamati respon sistem yang terjadi. Pengujian pada sistem ini dibagi

menjadi beberapa bagian, yaitu:

1. Pengujian Motor Pompa Air dengan PWM
2. Pengujian sistem open-loop
3. Pengujian sistem closed-loop

4.1 Pengujian Motor Pompa Air dengan PWM
Pengujian motor pompa air dilakukan untuk melihat keluaran debit air dari pompa

berdasarkan variasi tegangan motor. Motor pompa air pada pengujian ini  diatur
kecepatannya menggunakan variasi tegangan PWM. Setelah melakukan prosedur pengujian
menggunakan data pada Tabel 3.1, didapatkan hasil dari debit keluaran motor pompa air DC
seperti yang ditunjukan pada Tabel 4.1.

Tabel 4.1 Hasil Pengujian Motor Pompa Air dengan PWM

Duty Cycle (%) | PWM (m'?jmn)

0 0 0

5 13 0
10 25 0
15 38 0
20 51 1011
25 64 285.9
30 77 436,2
35 90 5685
40 102 673.,5
45 115 819,9
50 127 891
55 140 | 1056,9
60 153 1170
65 166 | 12246
70 178 1386
75 191 | 14565
80 204 | 1593.9
85 217 | 16206
90 529 " 17451
o5 242 | 18687
100 255 | 19476

23
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Tabel 4.1 menunjukan debit keluaran dari motor pompa air DC yang diberi masukan
tegangan secara bertahap hingga 12V. Pada PWM sebesar 51 motor pompa air DC mulai
mengalirkan air, sedangkan pada PWM 0 — 38 motor pompa air DC tidak mengalirkan air,
yang disebabkan oleh kecilnya arus yang mengalir pada rotor yang mengakibatkan motor
tidak memiliki cukup gaya untuk memutar rotor. Dari Tabel 4.1, debit keluaran maksimal
dengan tegangan 12V adalah sebesar 1947,6 mL/min, sedangkan pada spesifikasi motor
debit keluaran maksimal sebesar 2000 mL/min. Maka, motor pompa air DC mempunyai
error sebesar 2,65%.

4.2  Pengujian Sistem Open-loop

Setelah dilakukan tuning menggunakan PID Tuner, selanjutnya perlu dilakukan
pengujian sistem pada kondisi open-loop. Hal ini dilakukan untuk melihat respon sistem saat
diberi sinyal unit step agar sesuai dengan yang diinginkan. Setelah sistem diberi sinyal unit
step, didapatkan nilai rise time sebesar 0.072 detik, settling time sebesar 0.146 detik,
overshoot sebesar 3,64%, dan error steady state 2%. Hasil dari pengujian terhadap sistem
menggunakan kontroler PID dengan memberi masukan unit step pada sistem dapat dilihat

pada Gambar 4.1.

T T T {857 Bilevel Measurements

e High 9.870e-01

1= ————— e - Low 5.114e-03

[ Amplitude 9.819e-01
1

L L L

Gambar 4.1 Respon sistem menggunakan Kontroler PID dengan masukan unit step

4.3 Pengujian Sistem Closed-loop
Pengujian ini dilakukan untuk mengetahui performansi sistem ketika dalam kondisi

closed-loop. Setpoint yang ditentukan dalam pengujian ini adalah 500, 1000, 1500, 2000
mL/min. Tujuan dari pengujian ini untuk melihat respon sistem ketika diberi nilai setpoint

yang berbeda. Hasil dari pengujian ini dapat dilihat pada sub-bab 4.3.1 —4.3.4.
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4.3.1 Respon Sistem dengan Setpoint 500 mL/min

25

)

T T

77 Bilevel Measurements

4.986e+02

— B

o g

1 | 1 | L
' 2 s . s P ¥

2557400
4.960e+02

74872 ms
5300 (/ms)

0515 %
2577 %
0232%

Gambar 4.2 Respon sistem dengan setpoint 500 mL/min

Gambar 4.2 merupakan respon sistem yang digambarkan dalam bentuk kurva

keluaran debit air terhadap waktu dengan setpoint 500 mL/min. Dari pengujian ini

didapatkan nilai overshoot sebesar 2,5%, rise time sebesar 0.074 detik, settling time

sebesar 0,146 detik, dan nilai error steady state sebesar 0,8%. Nilai error steady state

didapatkan dengan mencari nilai rata-rata debit keluaran dengan setpoint yang

ditentukan.

|496 — 500
€ss (%) = TXlOO% =0,8%

4.3.2 Respon Sistem dengan Setpoint 1000 mL/min

T T

{5137 Bllevel Measurements
» Seftings
¥ Transitions
High 9.969+02

| 1 | |

Low 5.112¢+00
Ampltude 9.9180+02

+ Edges 1

+ Rise Time 75544 ms

+ Slaw Rate 10 503 (fms)

¥ Overshoots / Undershoots

+ Preshoot 0515%

+ Overshoot 2577 %
. ||+ undershoot 1.348 %
3 || + Settiing Time

1 3 5

Gambar 4.3 Réspon sistem dengan setpoint 1000 mL/min

Gambar 4.3 merupakan respon sistem yang digambarkan dalam bentuk kurva

keluaran debit air terhadap waktu dengan setpoint 1000 mL/min. Dari pengujian ini
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didapatkan nilai overshoot sebesar 2,5%, rise time sebesar 0.075 detik, settling time
sebesar 0,146 detik, dan nilai error steady state sebesar 0,82%. Nilai error steady
state didapatkan dengan mencari nilai rata-rata debit keluaran dengan setpoint yang

ditentukan.

1991,8 — 1000

ess (%) = 1000

x100% =0,82%

Nilai error steady state pada setpoint 1000 mL/min sedikit berbeda dengan 500
mL/min. Terdapat perbedaan error steady state sebesar 0,02%. Namun, hal ini tidak

terlalu mempengaruhi dari performansi sistem dan sistem masih dianggap baik.

4.3.3 Respon Sistem dengan Setpoint 1500 mL/min

T T T T 537 Blievel

1600 |- — | ¥ Transitons

|

Gambar 4.4 Respon sistem dengan setpoint 1500 mL/min

Gambar 4.4 merupakan respon sistem yang digambarkan dalam bentuk kurva
keluaran debit air terhadap waktu dengan setpoint 1500 mL/min. Dari pengujian ini
didapatkan nilai overshoot sebesar 2,5%, rise time sebesar 0.074 detik, settling time
sebesar 0,146 detik, dan nilai error steady state sebesar 0,86%. Nilai error steady
state didapatkan dengan mencari nilai rata-rata debit keluaran dengan setpoint yang

ditentukan.

|1487 — 1500]|
1500

ess (%) = x100% = 0,86 %
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Nilai error steady state pada setpoint 1500 mL/min sedikit berbeda dengan
1000 mL/min. Terdapat perbedaan error steady state sebesar 0,04%. Namun, hal ini

tidak terlalu mempengaruhi dari performansi sistem dan sistem masih dianggap baik.

4.3.4 Respon Sistem dengan Setpoint 2000 mL/min

{877 Bllevel Measurements

Gambe;tr 4.5 Respon sistemrdengasn setpo“int 2000 mL/anin
Gambar 4.5 merupakan respon sistem yang digambarkan dalam bentuk kurva
keluaran debit air terhadap waktu dengan setpoint 2000 mL/min. Dari pengujian ini
didapatkan nilai overshoot sebesar 2,5%, rise time sebesar 0.074 detik, settling time
sebesar 0,146 detik, dan nilai error steady state sebesar 0,8%. Nilai error steady state
didapatkan dengan mencari nilai rata-rata debit keluaran dengan setpoint yang

ditentukan.

11984 — 2000
ess (%) = Soo0 X 100% =089%

Nilai error steady state pada setpoint 2000 mL/min sedikit lebih baik
dibandingkan dengan setpoint 1000 dan 1500 mL/min. Namun, hal ini tidak terlalu

mempengaruhi dari performansi sistem dan sistem masih dianggap baik.
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BAB V
PENUTUP

5.1 Kesimpulan

Berdasarkan hasil analisis pada penelitian ini, maka dapat ditarik kesimpulan sebagai
berikut:

Performansi sistem dengan menggunakan kontroler PID memiliki nilai rise time
sebesar 0.0946 detik, settling time sebesar 0.146 detik, dan overshoot sebesar 1.96%
dengan nilai parameter K, 3,156, K; 1,0796, dan K4 2,3066. Sedangkan performansi
sistem tanpa menggunakan kontroler PID memiliki nilai rise time sebesar 1.27 detik,
settling time sebesar 10.8 detik, dan overshoot sebesar 37.4%

Performansi sistem closed-loop sudah sesuai dengan spesifikasi desain yang
diinginkan.

Perubahan nilai setpoint dari 500 — 2000 mL/min tidak mempengaruhi performansi

sistem

5.2 Saran

Saran yang diberikan untuk penelitian selanjutnya adalah:

Diperlukan parameter dari kontroler dengan metode yang lebih akurat dalam
penentuannya sehingga mendapatkan hasil yang memuaskan.

Diperlukan pengukuran nilai resistansi dan induktansi belitan pada motor pompa air

DC agar hasil simulasi lebih akurat.

29
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LAMPIRAN

Lampiran 1. Data Sheet Arduino UNO
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Product Overview

The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital
inputioutput pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a
USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in ltalian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions,
see the ndex of Arduino boards.
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Technical Specification

EAGLE fées: arduine-duemilanove-uno-design.zip Schematic: arduing-uno-schematic, pdf

Summar
Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital 'O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per /O Pin 40 mA
DC Current for 3.3V Pin 50 mA
Flash Memory 32 KB of which 0.5 KB used by
bootloader
SRAM 2KB
EEPROM 1KB
Clock Speed 16 MHz
the board
“Test”
Led 13
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Power
The Arduino Uno can be powered wvia the USB connection or with an external power supply. The power
source iz selected automatically.

External (non-USE) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
can be connected by plugging a 2.1mm center-positive plug into the board’s power jack. Leads from a
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an extemal supply of & to 20 volts. If supplied with less than TV, however, the 5V
pin may supply less than five volis and the board may be unstable. If using more than 12V, the voltage
regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power ping are as follows:

+« VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to
5 volts from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access it through this pin.

+ 5V. The regulated power supply used to power the microcontreller and other components on the
board. Thiz can come either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5% supply.
3V3a. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 ma.

GMND. Ground pins.

The Atmega32B8 has 32 KB of flash memory for storing code (of which 0.5 KB is used for the bootlcader); It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(}, and
digitalBead(} functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 m& and
has an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have
specialized functions:

+ Sarial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pinz are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip .

+» External Interrupts: 2 and 3. These pins can be configured to frigger an interrupt on a low value, a
rizging or falling edge, or a change in value. See the attachinterupt() function for details.
PWM: 3, 5, 6,9, 10, and 11. Provide B-bit PWM output with the analogWrited) function.
SPI: 10 (88), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPl communication, which,
although provided by the underlying hardware, is not currently included in the Arduino language.

+ LED: 13. There is a built-in LED connected to digital pin 13. When the pin iz HIGH value, the LED is
on, when the pin is LOW, it's off_
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The Unoc has & analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By
default they measure from ground to 5 wolts, though is it poszible to change the upper end of their range
using the AREF pin and the analogReference() function. Additicnally, some pins have specialized
functionality:

+« [PC: 4 (SDA) and 5 (SCL). Support I°C (TW!) communication using the Wire library.
There are a couple of other pins on the board:

+ AREF. Reference voltage for the analog inputs. Used with analogReference().
+ Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

See also the mappng between Arduino pins and Atmega328 ports.

Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on
digital pins 0 (RX) and 1 (TX). An ATmegaB8U2 on the board channels this serial communication over USB
and appears as a virtual com port to software on the computer. The "8U2 firmware uses the standard USB
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a seral monitor which allows simple textual data to be sent to and from the
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.

The ATmega328 also support [2C (TWI) and SP1 communication. The Arduino software includes a Wire
library to simplify use of the 12C bus, see the documentation for details. To use the SPI communication,
please see the ATmegai28 datasheet.

Programming

The Arduino Uno can be programmed with the Arduino software (download). Select “Arduino Uno w/
ATmega328" from the Tools > Board menu (according to the microcontroller on your board). For details,

see the [efarence and futorials.

The ATmega32B8 on the Arduino Uno comes preburned with a booticader that allows you to upload new code
to it without the use of an external hardware programmer. It communicates using the original STKS00
protocol (eference, C header files).

You can also bypass the bootioader and program the microcontroller through the ICSP (In-Circuit Serial
Programming) header; see these instructions for details.

The ATmega8U2 firmware source code iz available . The ATmegaBU2 is loaded with a DFU bootloader,
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and

then resetting the BUZ2. You can then use Atmel's FLIP software (Windows) or the DEU programmer (Mac

05 X and Linux) to load a new fimware. Or you can use the ISP header with an external programmer
{ovenrwriting the DFU bootloader).

RS ~radiospsres RADIONICS

AL B CTRo




4C.1

.ub

—
T
L
—
)
o
=
s

37

Automatic (Software) Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be reset by software running on a connected computer. One of the hardware flow control
lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega328 via a 100 nanofarad
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR
can be well-coordinated with the start of the upload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or
so, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything
besides an upload of new code), it will intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-time configuration or other data when it
first starts, make sure that the software with which it communicates waits a second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.

USB Overcurrent Protection

The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload is removed.

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple
of the 100 mil spacing of the other pins.
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is
programmed using the Arduino programming language (based on Wiring) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage

Linux Install Windows Install Mac Install

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Blink led
Now you're actually ready to “burn” your 8 Bk | Arduno 4017 ~g=1
first program on the arduino board. To
select “blink led", the physical translation (&) Bl E[E R 5
of the well known programming “hello &

world", select

LedPin » 13;

File>Sketchbook>
Arduino-0017>Examples> wtwpdl |
Digital>Blink tade (SadP1n, OUTVT):

Once you have your skecth you'll
see something very close to the
screenshot on the right. ,

In Tools>Board select EEtu Loaria; LS

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to.

fom |

4=h o

Done compiling . TQ
C

Press Compile butten
(to check .{o:errnr‘sl TX RX Flashing Blinking Led!

RS ~radiospares RADiONICS /“,!
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Lampiran 2. Data Sheet Driver Motor BTS7960

Handson Technology

User Guide

960 High Current 43A H-Bridge Motor Driver
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The BTS7960 is a fully integrated high current H bridge module for motor drive applications. Interfacing to
a microcontroller is made easy by the integrated driver IC which features logic level inputs, diagnosis with
current sense, slew rate adjustment, dead time generation and protection against overtemperature,
overvoltage, undervoltage, overcurrent and short circuit. The BTS7960 provides a cost optimized solution
for protected high current PWM motor drives with very low board space consumption.

SKU: DRV-1012

Brief Data:
e Input Voltage: 6 ~27Vdc.
Driver: Dual BTS7960 H Bridge Configuration.
Peak current: 43-Amp.
PWM capability of up to 25 kHz.
Control Input Level: 3.3~5V.
Control Mode: PWM or level
Working Duty Cycle: 0 ~100%.
Over-voltage Lock Out.
Under-voltage Shut Down.
Board Size (LxWxH): 50mm x 50mm x 43mm.
Weight: ~66g.

1 | www.handsontec.com




Mechanical Dimension:
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43mm

2 www.handsontec.com
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4C.1

Schematic Diagram:

b

Microcontroller Voltage Regulator Reverse Polarity
Protection
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High Current H-Bridge

Control Input Pin Function:

1000000 FA0000E a8

of ﬁ B

Control Input

Pins
Pin No Function Description
1 RPWM Forward Level or PWM signal, Active High
2 LPWM Reverse Level or PWM signal, Active High
3 R_EN Forward Drive Enable Input, Active High/ Low Disable
4 L_EN Reverse Drive Enable Input, Active High/Low Disable
5 R_IS Forward Drive, Side current alarm output
6 LIS Reverse Drive, Side current alarm output
7 Vce +5V Power Supply microcontroller
8 Gnd Ground Power Supply microcontroller

3 www.handsontec.com
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Motor Power Supply & Output Pin Assignment:

Power Supply Motor Output
Input Pin Pin
Pin No Function Description
1 B+ Positive Motor Power Supply. 6 ~27VDC
2 B- Negative Motor Power Supply. Ground
3 M-+ Motor Output +
4 M- Motor Output -

Controlling DC Motor with BTS7960 Using Arduino:

Below is the circuit connection using BTS7960 high power driver to control one DC motor with Arduino
board. The potentiometer allows the control of motor speed and rotation direction of the motor.

www.handsontec.com
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RxEE Arduino "

Arduino to BST7960 Connecting Table:

BST 7960 Pin

.....
-----
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.....
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ooooo
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ooooo
.....
-----
.....
.....
.....
.....
.....

Arduino Pin

1 (RPWM) D5

2 (LPWM) D6

3 (R_EN) Arduino 5V
4 (L _EN) Arduino 5V

5 (R_IS) Un-connected
6 (L IS) Un-connected
7 (VCC) Arduino 5V

8 (GND) Arduino GND

www.handsontec.com
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Lampiran 3. Data Sheet sensor Water Flow YF-S201

MODEL: YF-S201
Description:
Water flow sensor consists of a plastic vaive body, a water rolor, and a hall.effect sensor. When water flows through the rotor, rotor rolls. Its speed changes with
different rate of flow. The hal.effect sensor culputs the corresponding pulse signal. This one is suitable 10 dedect flow in water dispenser or coffee machine. We
have a comprehensive line of water flow sensors in different diameters. Check them out to find the one thal meels your need most.
Features:
Compact, Easy to Install
High Sealing Performance
High Quakty Hall Effect Sensor
RoHS Complant
Specifications:
Working Voltage: DC 4.5V-24V
Normal Voltage: DC 5V~18V
Max. Working Current: 15mA (DC 5V)
Load capacity: s 10 mA (DC 5V)
Flow Rate Range: 1~30U/min
Load Capacty: s10mA (DC 5V)
Operating Temperature: S80°C
Liquid Temperature: $120°C
Operating Humidty: 35% ~90%RH
Allowing Pressure: s1.75MPa
Storage Temperatre: 25+ 80°C
Storage Humidity: 25% ~95%RH
Electric strength 1250Vimin
Insulation resistance 2 100MQ
External threads: 1/2°
Outer diameter: 20mem
Inlake dameler: 9mm
OCutlet diameter: 12mm
Application:
Watter heaters, credit card machines, waler vending machine, flow measurement device!
Cercuit: Red: Positive
Black: GND
Yellow: Output signal 840
Flow Range: 100L/H-/1800H-L/H 720 ———1—— e T
Flow (UH) |Frezg.(Hz)| Erro range |
120 16 600
230 32 480
380 493 +10
480 65.5 5% 360 — = 1 I b1 10 b1t 5
600 82
720 90.2 ]2;8 *
32.5 49.5 655 82 90.2 (HZ)
__GND()
N* |ltem Matenal
1 |Wie PVC
2 |Bonnet PA
3 |Screw Zinc Plated
4 |Vaive Body PA
5 |Press Valve
6 |Magnel
7_|Hall
8 |Impefier POM
9 |Steel Sharft | SUS304
Ciosad




